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NOTE: This is the first version of this manual and I wanted to keep it as short as possible.  I have 

therefore only included the basics of using this software.  Based on feedback I will flesh out the 

manual to include more details where required.  Also, there will be a number of videos 

demonstrating the features of WCS, and these will be available in the WCS forum. 

 

In addition to this PDF document, there are a number of Video Tutorials on Web Content Studio that 

cover most aspects of the program.  You can watch them on the Web Content Studio Website: 

http://webcontentstudio.com/web-content/tutorials/ 

 

 

BTW, When you first start WCS, you’ll only see three tabs across the top.  Please read this manual to 

find out why.  It is not a bug, yet a lot of people ask about this (obviously they haven’t read the 

manual). 

http://webcontentstudio.com/web-content/tutorials/
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What is Web Content Studio? 

Before we look at what Web Content Studio can do for you, let’s look at the typical work-flow you’ll 

go through as you develop your site content: 

 

Web Content Studio was designed to help with each step in this process.  

This manual is organised into sections which mirror the diagram above.   
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The following is a quick reference table showing the various tasks this software is designed to do and 

how they map to this user guide: 

Flow Diagram Section in this Manual/Software 

Research Ideas for Content Researcher Tab 

Choose an Article & Find Theme Words for an 
article. 

Notes & TodoList Tab + Keywords Tab 

Check Theme Words are the best Possible Reports Section of the Editor 

Write Article WYSIWYG Editor + Article templates 

Check Article for Good Themeing Reports Section of the Editor 

Get Content out of the editor in the most 
suitable format for easy publishing 

Export Article on Editor Screen 

  

 

Before we look at an Overview of the software interface, there are a couple of things you MUST do 

when you start Web Content Studio for the first time: 

 

1. Enter your username and password. 

2. Setup the dictionary. 
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Entering your username & password 

On the Home tab, click the “User Details” link to open the User Detail screen: 

 

Enter the username and password you received when you purchased this software (the same ones 

you used to login and download it).  Once these are entered, click the Save button.  This will save 

your details and close this screen. 

IMPORTANT:  The license of Web Content Studio allows YOU and only YOU to use the software on 

any of your own machines.  If you share your username and passwords with other people, your 

account will be automatically locked and the software will stop working.  If you know someone who 

wants to use the software, send them your affiliate link  
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Setup the Dictionary 
In the Options menu, select Spell Checker to open the Spell Checker Options screen: 

The dictionaries should already be setup, but in the rare occasion they are not, follow the 

instructions below. 

Click on the Language tab, and if you don’t see a list of 

dictionaries in the list box (highlighted in yellow in my 

screenshot), click the Locate Dictionaries button, and navigate 

and select the “Dictionaries” folder inside the Web Content 

Studio application data folder.  You can find out where this 

folder is on the about screen and if you need help, contact me 

via the forum. 

You should then be able to select the language from the drop 

down box (highlighted in green in my screenshot). 

If you find that your language is not included, you can 

download other available dictionaries from this site.  Just 

download and unzip into the Dictionaries folder of Web Content Studio.  When you install your own 

dictionaries in this way, you will need to restart Web Content Studio before the new dictionaries are 

found. 

 Once you have selected the dictionary, you are 

ready to start using the editor.  When you type 

in the WYSIWYG editor, if you see squiggly lines 

under all of the words, then you have not 

selected the dictionary for your language. 

http://www.addictivesoftware.com/addict3/dicts-extern.htm
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Overview of the User Interface 
 

The interface of Web Content Studio (WCS) is designed to make things as intuitive as possible. There 

are 2 main navigation aids to find your way around the software: 

1. The Main Menu.  This menu only has basic options like Open/New article, Exit and help.  

There is also an options menu to allow you to setup the Spell Checker. 

2. The Section Tabs – these are the tabs that you can click to take you to the main sections of 

the software. There are tabs for Home, Researcher, Editor, Keywords and Notes. 

Below you can see a screenshot showing the positions of the main menu and the section tabs: 

 

Note: there are tabs within some of the sections of this software.   

E.g. you can navigate between WYSIWYG editor, Source code and Plain text screens within the Editor 

tab.  

 You can also navigate the various screens of the Keywords tools using tabs within the Keyword Tab.  

Notice the extensive use of tabs within the Keyword Spider tool: 

 

 

Although these screenshots may make WCS look complicated, when you actually use the software I 

am sure you will find that the tabs are intuitive and help speed up your work because of the ease of 

finding and moving to different areas of the software (nothing is hidden within menus). 

With that said, let’s explore the various sections of the software, starting with the Home tab. 
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Quick Start Tab 
 

The Quick Start Tab is basically a simple set of instructions to help you get started using Web 

Content Studio.  You can hide this window by selecting the Hide This Tab check box if you don’t want 

to see it in the tab list. 



11 
 

Home Tab 

 

The home tab is the welcome screen for WCS.  It’s the 

starting point for opening or creating a new article.  The 

exact screen you see may be a little different to the one on 

the left, because as this software matures, it is likely that 

new features will be added, and some may then be added 

to this home tab. 

 

 

 

 

When you first start WCS, you’ll only see three tabs in the same row as the Home Tab.  These are 

Home, Researcher and Keywords: 

 

 

Once you open up or create a new article, other tabs that are relevant to the project/article will 

appear (Editor & Notes): 

 

 

To get started on a new Article, click the Open/New Article link.  Alternatively, you can select 

Open/New Article from the File Menu at the top. 

The Article Manager Screen will open. 
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The Article Manager 
 

 

On this screen, you can setup new projects (a project is a collection of articles), create new articles, 

or delete existing articles and projects via the two large buttons on the right. 

There is also a button that can control importing and exporting of articles.  Articles can be exported 

in two formats:  

1. plain text files which include just the articles in that project,  

2. WCS Format which include the html format article, plus two additional files containing 

theme words and theme phrases.  The WCS format is useful for sharing content between 

computers as the formatted article and theme words & phrases are all available for import.   

The Importing of articles works in the opposite direction obviously, but the two formats are the 

same.  You can import plain text articles (no theme word lists) or WCS format articles (which 

contain any theme words & phrases that were in the original article that was exported). 

When you select a project on the left, any articles in that project will be listed on the right.  To open 

an article either double click the article in the list, or select it and click the Load Selected Article 

button. 
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To create a new article: 

1. If no projects exist, create one by clicking the Projects button, clicking New Project, and 

typing in a name for the project.  If the project you want to create the article in already 

exists, simply select it from the Project list. 

2. Click the Articles button, and click the Create New Article in selected project. 

3. You will be prompted to type in a name for the article.  If you leave it as the default “article” 

title, no article will be created.  You need to type in a proper article title. 

4. When you type in your article title, the article will be created in your database.  You’ll see it 

in the list, so can open it by double clicking, or selecting it and clicking the Load Selected 

Article Button. 

 

To Delete an Article or Project: 

1. Select the article (or project). 

2. Click the Articles (or Projects) button. 

3. Select Delete Selected Article (or Project). 

 

Note that if you delete a project, ALL articles in that project will be deleted as well. 

 

 

To Rename a project or article: 

1. Select the project or article. 

2. Click the Project or Article Button and select the rename option.  

3. A dialogue box appears allowing you to rename it. 
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 Researcher Tab 
The researcher tab will help you collect useful research for your articles.  It consists of: 

1. Web Browser 

2. Bookmarks 

3. Scratch Pad and associated functions. 

 

 

To activate the bookmarks, click the Bookmarks tab on the left.  The bookmarks panel will pop out 

allowing you to select any of the resources (or add your own). 

The scratch pad is a place to store your research.  There are various tools to help you extract the 

information you want to keep from the websites you visit like the Strip HTML functions button at the 

top of the screen.  We will look at those in a little more detail in a moment. 
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Bookmarks 

Bookmarks are there to store useful websites you use regularly.  I have included some with WCS, but 

you are free to add/delete categories and websites yourself. 

 

On the left hand side of the screen are categories of bookmarks.  When you click on a category, the 

list of bookmarks in that category opens up on the right hand side.  Clicking a bookmark in the list 

will open that bookmark in the web browser. 

Wherever a folder has a little triangle next to it, that folder has sub-folders.  

 

 To view the sub-folders, click the triangle. 
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There are a group of buttons to add/edit/delete folders 

 

To the right of these 6 buttons are a set of buttons to add/edit or delete the actual bookmarks: 

  

When you add a bookmark, the URL and Name boxes become editable as well as the checkbox and 

you can type directly into them.  

 

When you have finished, click the Save Button, and your new bookmark will appear in the list under 

the selected category. 
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Opening a Bookmark in an External Browser 

Some sites you bookmark may through up Javascript errors which can be annoying.  This is a 

limitation of the internal browser in WCS, so you can choose to open certain bookmarks in an 

external browser.  If you want to do this, just check the “Open This Bookmark In External Browser” 

checkbox for that particular bookmark.   

 

Editing Existing Bookmarks 

To edit an existing bookmark, select the folder where the bookmark is found, and then use the 

previous / next buttons to make sure the bookmark you want to edit is shown in the URL and Name 

Box: 

 

You can now type directly into the URL and Name boxes (and change the status of the checkbox).  As 

you do so, the Save and Cancel Changes buttons become active. 

 

To save changes, click the Save Changes button.  To cancel changes, click the cancel button. 
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Extracting Information from a webpage 

 

The Strip HTML button offers some useful functions when you are visiting a website for research: 

 

It allows you to strip out the link text, strip out headers or show visible text on the page you are 

visiting.  This information is sent to the scratch pad.  For example, selecting Show Visible Text while I 

am at the Google homepage results in my scratchpad looking like this: 

 

Notice that there are some buttons on the right.  The first button allows you to send the contents of 

the scratch pad to either Notes, or Project Todolist.  E.g. Imagine your scratchpad looks like this: 

 

Sending these to the todolist (or even notes) will mean you can keep a permanent record of your 

product list.  

We will look at Notes and Todo lists in more detail later in the manual. 
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The Process Button allows you to do some processing on the scratchpad contents: 

 

The options here do the following: 

Remove Lines (Containing) – Will remove lines that contain the  word or phrase you specify in the 

popup box that appears when you click this item. 

Remove Lines (Exact) – Will remove lines that are exactly the same as you type into the popup box. 

Remove Numbers – Remove all numbers from the scratchpad. 

Only include lines that have.. – Will remove all lines except those that contain the word or phrase 

you specify. 

Sort Scratchpad – Will sort the lines of the scratchpad alphabetically. 

 



20 
 

 

The Grabber Button 

 

On the Scratchpad screen you’ll notice the grabber button.  This is a tool to help you research your 

niche.  Click the button once, and it will start the grabber.  Now, whenever you copy any text to the 

clipboard (from any application), that text will be copied to your scratchpad. 

e.g. If you are reading articles in your niche and you find an interesting fact you want to use in your 

article, simply copy it to the clipboard, and as long as the grabber is active, that text will be pasted 

automatically into your scratchpad. 

 

 

The Wrap checkbox on the scratchpad does exactly what it says – it wraps the text on your 

scratchpad. 
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Editor Tab 
The editor tab is where you create your content.  This tab has a large toolbar at the top.  The best 

way to find out what each of the buttons does, is to move your mouse over each one.  A tooltip will 

appear telling you what the button does. 

 

This toolbar makes the editor What You See Is What You Get (WYSIWYG).  You can format your 

articles, insert images, hyperlinks etc using these buttons as well as the usually copy, paste, save etc.  

There are also some basic features to help support tables (in case you want to use tables in your 

article).   

 

NOTE: In the Options - > Theme Report & Software Settings, there is a tab called “Other” that allows 

you to increase or decrease the size of the font used in the WYSIWYG editor: 

 

A Note on using images: Images need to be on your web server if they are going to display in your 

articles.  If you are pasting the final article into a tool like Windows Live Writer, then you don’t have 

to worry about this, just copy the entire article directly from the WYSIWYG editor and paste it into 

Live Writer.  Images will be handled correctly.  However, if you are going to export the article from 

WCS into HTML format, you need to specify the URL of the image on your server as the image 

location (and not the image on your hard disk). 

The editor itself has three tabs: 
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The WYSIWYG is probably the only tab you need to work with, but you can also view the articles as 

HTML on the source tab: 

 

You can edit the source (e.g. adding meta tags, title etc) and save those changes using the save 

button on in the toolbar.   Any changes you make to the source will then be saved.  This allows WCS 

to be used as a complete web page editor as well as just an article editor. 

The Plain Text tab is not editable - it is just there for your own reference and will display the text of 

the article / web page. 

 

Saving Articles 

WCS will always try to save an article before you close it, or the program.  However, for those who 

are of nervous disposition, there is a save button in the toolbar as well as a “Save As..” button that 

allows you to create a copy of the current article in the same or different project. 

 

 

Using the Save button is fairly simple.  Just click it to save and whether you are working on the 

WYSIWYG editor or the source tab, the changes you have made will be saved. 
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The Save As button works a little differently to a conventional document editor because your work is 

being saved in a database, not in a separate file on your hard disk (you can do this using the export 

button).  Therefore, when you want to “Save As”, to make a copy of the existing file, you actually go 

and create a new article in the database into which the work will be saved.  This means selecting the 

project, entering a filename etc.  Let me walk you through this. 
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Using Save As 

When you click the save as button, two screens open – the Article Manager screen, and a help 

screen (which you can disable with the check box): 

 

Following the instructions on the help screen, simply select the project you want to save your article 

in (or create a new project for the article).  When you have the project selected, click on the Articles 

button and select “New Article in Selected Project”: 

 

You will be asked to type in a name for the article: 
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When you have typed in the name, click the OK button. 

That’s it.  The article has now been saved with the new name, and it will open in the editor 

immediately after the save. 

You can confirm this by looking in the title bar at the top – your new article title appears: 

 

When you Save As, you also have the option of over-writing an existing article with the copy.  TO do 

this, rather than creating a new article to save the copy, just select an existing article and double 

click it (or select it and then click the Save As button). 
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Export Articles – Getting articles out of WCS 

There are a number of ways you can get articles out of WCS.  The first, and easiest way is to highlight 

the contents of the WYSIWYG editor and then select copy (or CTRL + C) on your keyboard.  You can 

easily highlight the WYSIWYG editor contents by clicking your mouse into the editor, and pressing 

CTRL + A on your keyboard.   

This method is the one I use when I am pasting the article directly into Windows Live Writer (WLW).  

Images and hyperlinks will all be copied across into WLW ready for posting on my site. 

The other way to get content out of WCS is to use the Export button on the toolbar.  This button has 

a menu attached to it: 

 

There are two basic options, each with sub-options.   

These main options are to save the article to a physical file on your hard disk OR to save the article 

to the clipboard (read for pasting into another application). 

Physical File Options are: 

HTML – Just the Article: This option saves the content of the <body> region in the article.  This is the 

place where the article is found inside the HTML document.  This is the option you will use if you 

want to get just the article, formatted correctly with html, e.g. to paste into a webpage template. 

HTML – FULL HTML: This option saves the entire HTML webpage including header and anything else 

you may have added in the source window. 

Plain Text: This option simply saves the plain text of the article (without any formatting) to a text 

file. 

 

 

Clipboard Export Options are: 

WYSIWYG Editor: The contents of the WYSIWYG editor.  This is the same as selecting the WYSIWYG 

editor box and pressing CTRL + A to highlight, then CTRL+C to copy. 

Text File: Copies just the plain text to the clipboard. 
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Full HTML: Copies the FULL HTML of the web page to the clipboard. 

Article HTML: Copies the HTML formatted article to the clipboard.  Note that it actually copies the 

contents of the <body> section of the web page. 
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Article Templates 
 

Article templates are a way to speed up article creation using commonly used templates for the 

structure of the article. 

To access the article templates screen, click the Article Templates button on the editor screen. 

 

When the screen opens, this is the screen you will see: 

 

To see available Article Templates, click the Article Templates button and the template list will slide 

out (there are two templates included with WCS): 

 

Select a template from the list to open it: 
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Each Article template is made up of a number of modules.  In the following screenshot the first 

module is highlighted: 

 

You can adjust how many modules are shown on the screen using the spin edit box at the top 

labelled “Show Modules”.  Each Module is made up of: 

1. Order – this is the order the module appears in the template. 

2. Type – this tells WCS how to handle the module.  Types can be H1..H6, Paragraph, ordered & 

numbered lists. 

3. Text – this is the text to display in the article created from the template.  This is used to 

remind you what you need to type. 

Creating your own Article Templates 

If you want to create your own templates, click the Article Templates menu item at the top, and 

select “Create a New Template”.  You will be asked to give the template a name.  You will be 

returned to the main screen again, where you can click the Add New Module button to insert a 

module.  NOTE: The button next to this one deletes the selected module. 
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When you insert a new module, the following screen appears: 

The order should be inserted for you, and the default 

“Paragraph” selected.  You can change the Type if you want, 

then type in your reminder text before clicking Accept, which 

will insert the module into the template. 

Your module will then appear in the Article Template.   

Repeat with each section of your template 

 

 

 

Using Article Templates 

Article templates are meant to be a guide to help you writing content.  When you want to use a 

template, select it, and then switch over to the “Create the Skeleton Article” tab. 

 

 

There is a large button labelled “Create Article Template”, which opens a menu with two options: 

1. Copy HTML to Clipboard – copies the skeleton article in HTML format to the clipboard. 

2. Send HTML to Editor – creates the skeleton article in the WYSIWYG editor.  If you create the 

skeleton article while another article is open, this WILL OVER-WRITE the existing article.  If 

you do not want to do this, simply go and create a blank article first before creating the 

skeleton article.   
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Let’s have a look at what is created when we send a skeleton article to the WYSIWYG editor: 

 

You can see that the modules defined in the article template are converted to HTML, and a skeleton 

article is created ready for you to edit.  You simply go through the skeleton article, editing each bit to 

answer the questions posed by the text.  Highlight the title, and then type in your title.  Then 

highlight the first paragraph, and type in your response, and so on.  

Article Templates can help you stay focused.   
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The Keyword Bar 
 

The keyword bar in the large bar on the right hand side of 

the WYSIWYG editor.  This bar is where your keywords 

and key phrases are stored for the article you are working 

on, as well as running the various reports on the article: 

There are 3 “tabs” on this Keyword Bar: 

1. Theme Words 

2. Theme Phrases 

3. Reports 

 

To access each of these three tabs, simply click the “bar” 

with that title.  These three bars are marked with arrows 

on the screenshot on the left. 

 

Theme Words – single words you want to target in your 

article. 

Theme Phrases – multi-word phrases that you want to include in your article. 

Reports – These are the reports you can run on your articles.  We will look at those in a moment. 

 

When you add keywords or phrases to your article, they appear in the theme word or theme phrase 

lists.  When the theme word tab is selected, you will see the following at the bottom of the theme 

word box: 

 
 

There is a button to add/edit keywords manually (though adding theme words will be done mainly 

by using the keywords tab in WCS). Under this button is some data.  When you click a theme word, 

this information will be updated based on the article in the WYSIWYG editor. 

 

Density – shows the density of the theme word you have selected in the article. 

Prominence – This is a measure of where the theme words appears in the article.  If the word is the 

first word in the article, it has a prominence of 100%.  If it is the last word in the document, it has a 

prominence of 1.  The 1st occurrence figure is the prominence of where the theme word first appears 

in your article.  The average prominence is the average prominence of that theme word in the 
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article.  An average prominence of greater than 50% indicates that the keyword is concentrated 

more in the first half of the article.  A percentage lower than 50% indicates the theme word is found 

more in the second half of the article. 

 

On the Theme Phrase tab, the prominence figures are not available, but the density of the theme 

phrase will be displayed for the phrase you have selected. 

 

NOTE: On the Theme Phrase Tab 

 

 
 

You will notice a button labelled “Generate theme words”.  This is a useful button because it will 

take all of the words that make up the theme phrases, and add them to the theme word list 

(assuming they don’t already exist).  This can increase your theme word list be quite a bit if you have 

a long list, and ensures that the important words that make up these phrases are included in your 

page. 

 

However, I would recommend that you always “clean” your theme word list using the Check against 

top 10 report discussed in the next section.  This will ensure that you prioritise the very best theme 

words in your article. 
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The Reports Tab 

 

This is where you analyze your articles.  There are 4 possible 

“reports” you can run. 

 

Check Keywords:  A simple report that checks your chosen 

theme words and phrases against the article.  You’ll get word 

and phrase counts, as well as sections in the report telling you 

which theme words and phrases are not found in your article. 

 

 

 

Keyword Map: This is a visual report showing you where your words and phrases appear in your 

article.  Its a good way to see if there are any “gaps” in your themeing. 

 
Theme words are highlighted in yellow.  Wherever you see a blue bar, this indicates that the theme 

words on either side of the blue bar are found in a theme phrase.  For example, the very first words 

in the article above are “diabetes alert dogs”.  You will see that each of the three words are 

highlighted in yellow, indicating they are theme words, but these words are also joined by blue bars, 

indicating that “diabetes alert dogs” is a theme phrase. 

 

The Theme Report is the most detailed in terms of article themeing.  You get the same information 

as the Check Keywords report (in other words, word and phrase counts plus what is missing from 

your article), plus an article summary. 
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This summary tells you how well your article is themed against your selected theme words and 

phrases. 

 

The overall theme score is based on the single words that make up your theme words and phrases.  

It does not look at the theme phrases as part of the calculation. 

 

You will notice that at the bottom, there is a Theme Score and Quality Theme Score.   

The Theme Score is a measure of how well themed your article is against your list of theme words.  

The Quality Theme score tries to implement a measure of over-optimization.  For example, in the 

article above, the article is 31.6% themed, meaning 1 theme word every 3.6 article words.  This 

might appear to the search engine as if the theme words have been stuffed, and the quality theme 

score can alert you to this.  
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The exact percentages used to assess over-optimization are set in the settings screen, though if you 

don’t know what you are doing, I recommend you set them as shown below. 

 

  
The above screen shows the settings for the theme report (accessed via the Options - > Settings 

Menu). 

   

At the top of the screen you can specify “maximum” densities for theme words and phrases.  If any 

theme word or phrase is used more than that density, you will get a warning in your theme report.  

Of course, you can ignore that warning if you want to – these are just indicators to you.  Here is an 

example warning for a theme word that exceeded my specified limits: 

 
 

 

 

In the settings screen you also have a section for Over-Optimization Penalty levels. 

 

You can set 9 levels of penalty.  In the above screenshot, a penalty of 0.1 is applied if the percentage 

themeing is over 45% (ie in theme word every 2.2 article words).  What does the 0.1 penalty mean?  

Well, once a theme score has been calculated for your article, that theme score is multiplied by 0.1.   

Note that theme scores are not limited to 100% during the calculation.  The system used is not one I 

want to share details about, but it seems to work very well.   

 

Let’s take an example. 
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Imagine you have an article with a percentage themed of 30%.  That means a 0.5 penalty would be 

applied.  If the calculated theme score was 130, after the 0.1 penalty was applied, the final quality 

theme score would be just 13% - (130 x 0.1). 

 

On the other hand, if percentage themeing of your article was just 13 % (1 theme word every 7.7 

words), the 0.9 penalty would be applied to the 130 calculated theme score, meaning an overall 

Quality theme score of 117, which would be reported as a maximum 100% quality theme score (as 

the theme score and quality theme scores reported in the report have a maximum of 100%). 

 

It’s not important that you understand how the calculations are done, just that it provides a good 

indicator of how well themed your content is, as well as potential over-optimization.  However, 

remember, this is not a science, and any figures in the theme report scores should be used as an 

indicator only to help you theme your content. 

 

Theme score and quality theme score are linked closely.  If they are different, it’s simply because of 

the over-optimization penalties we discussed earlier having been applied.  However, if your theme 

score is low, here are some things you can try to increase the theme score: 

 

1. Increase the number of theme words and phrases you are targeting.  The number you 

should be targeting depends on the subject you are writing about as well as how long your 

articles is.  I try to have at least 30 theme words, and a few theme phrases (this might be 4 

or 5 maximum). 

2. Increase the length of your article. 

3. Make sure that you don’t over-use any particular theme word or phrase.  Pay attention to 

your density limit warnings.  Any word that is over-used can indicate spam to a search 

engine. 

4. If your theme report indicates words or phrases that have not been included, include them 

OR remove them from your theme word list if you decide they are not necessary.  You can 

refine your theme word list using the last button on the reports section – Check Theme 

Words Against Top 10. 
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A nice feature in the Theme Report Screen is a button in the toolbar at the top: 

 

You’ll notice in the example above that some theme words were not found in the article.  Clicking 

the “Open Missing Keywords Helper” button at the top will help you add these to your article: 

 

Any theme words and phrases that you targeted that were not found in the article are added to this 

screen.  Double clicking a theme word or phrase copies it to the clipboard so you can paste it into 

the article. If you have the “Delete on Double Click” check box checked, then as you double click a 

word or phrase, it disappears from the list.  This way you can quickly and easily add those missing 

theme words and phrases to your content. 
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Check Theme Words Against Top 10 

 

 

When you click this button, you are prompted to enter the main phrase for your article.  When you 

enter this and click OK, WCS queries Google, and then checks your theme words against the top 10 

ranking documents in Google.  You’ll  get to see exactly how many of those top 10 pages included 

each of your theme words, and automatically delete any that did not occur on at least X of those top 

10 pages.  Let’s look at an example. 

In my article about Diabetes Alert Dogs, I can check my list of theme words against the top 10 for the 

phrase “diabetes alert dogs”: 

 

WCS goes away and checks my theme words against the top 10 pages in Google and returns with a 

report: 
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On top of the report is another screen that asks if I want to automatically remove theme words that 

do not appear on 5 of the top 10 pages.  You can change the 5 to more or less if you want, or even 

just close the screen without this “theme word stripping”. 

If I pressed OK, any theme word that did not appear on 5 or more of the top 10 pages in Google 

would be automatically removed from my theme word list.  This ensures that I concentrate on only 

the most important theme words in my article. 

Let’s see what the report itself offers us. 

For each of the top 10 results, there is a small analysis of the page: 
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If any pages could not be reached, there may not be 10 pages included in this report. 

At the end of the report is a section that lists how many of the top 10 pages my theme words were 

found on: 

 

Using this report you can quickly see which of the theme words you have chosen are important, and 

which are less so. 
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Keywords Tab 
The Keywords Tab of WCS is one of the most important, because it allows you to select the theme 

words for your articles based on two very powerful tools – Keyword Spider & Google Synonyms  

Let’s look at the Google Synonym tool first. 

This tool basically tells you the synonyms that Google thinks is important for a particular search 

phrase.  For example, if I type in “diabetic alert dogs” into the synonym tool, here are the results 

that WCS returns: 

 

I can hold down the CTRL key and select multiple words / phrases from this list, and then click the 

Add these to compiled list button to move those across to the right hand panel.  The right hand 

panel will be the list of words and phrases that I eventually assign to the article.  When the words 

are added to the right panel, they disappear from the left panel.  

I could then go and do another search, maybe “diabetes service dogs” and get more phrases that I 

can move across to my compiled 

list. 

By repeating this with relevant 

searches, I can come up with a lot 

of potentially important words 

and phrases. 
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When I am happy with my final list of “synonyms”, I can click the “Save to Keyword List” to have 

those words and phrases added to my theme word and theme phrase lists. 

  

 

While the synonym generator can get you a lot of great theme words and phrases, the real power of 

theme word generation comes from the Keyword Spider: 
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The Keyword Spider 
 

Those who have used KRA Pro (or Niche Blueprints) will be familiar with this tool although there are 

a few differences.  The screen gives you a few options: 

 

 

On the right hand side, you can select one of the available Google centres.  Most people will leave 

this as google.com.  If you want to change to a centre in your own language, make sure you also 

Launch Google Language Preferences (the button under the country settings) and select your 

language there as well. 

Using the Root Phrase to Find theme words 

On the left hand side of the spider screen, you have a box to enter your Root Phrase.  This is the 

main phrase of your article that the Keyword Spider will use to query Google and find theme words 

from the top pages.  E.g. if you were writing about diabetes alert dogs, that is what you would type. 

In most cases the spider will return plenty of theme words and phrases.   

NOTE: The spider works by looking at the top pages in Google (the number depends on what you 

have in the “Base On Top..” box of the spider screen), so if you type in an obscure search phrase, the 

spider may not have any relevant pages to work from.  This is the time to broaden your root phrase.    

In my diabetes alert dogs example, I actually got plenty of data back, but if I didn’t, I could repeat the 

spider using a slightly different phrase, or even broaden it to just the word diabetes.  This could 

return a lot of relevant words and phrases if I needed them.   
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Using a Custom List of URLs to Find theme Words 

 

There may be occasions when you have a list of URLs that you want to spider for theme words.  E.g 

you may want to see what theme words a particular group of competitors are using, so copy their 

URLs to a text file.  You can then get WCS to use this custom list of URLs to find theme words instead 

of basing theme words on the top x pages in Google. 

The format of the text file is as follows: 

1. 1 URL per link 

2. URL includes http:// 

3. No blank lines in the text file 

Below is a screenshot of an example file that could be used: 

 

 

If you get the format of this wrong, the Spider may not work properly. 

In order to use a file like this, simply use the button to select it from your hard disk. 
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The filename will appear in the text box, and those URLs will then be spidered.  If you start to type 

anything in the Root Phrase box, this will cancel the custom URLs process and set the spider up for 

using the root phrase instead. 

 

OK, Ready To Spider? 
 OK, before you send the spider off to Google, you need to make a decision.  The spider can work on 

Meta keyword tags only, or Page Text.  The difference is simple: 

Meta Tags Only – only strips theme words from meta keywords tag.  This is limited, but will return 

results more quickly.  However, be aware that a lot of pages don’t list meta keywords and even 

those that do, don’t always include the best phrases. 

Page Text – This uses both the meta tags AND the on page text to find theme words.  This is the 

most complete way to find theme words, but can take a few minutes to return data (depending on 

the speed of your computer).  However, this is the method I recommend you use. 

When you select the Page Text Option, a few more options appear on the screen: 

 

Firstly, on the right, you will see a box that says “Top X Page Words to Analyze”.  The default is set to 

1500, but if you have a slow computer, you can reduce this down to 500 or so.  That means the 

spider will then only analyze the top 500 words on each of the top pages in Google.  This speeds up 

the fetching of theme words, and the fact that most important words appear at the top of each page 

anyway, means you won’t miss much. 

Bottom left are three check boxes.  This tell the spider what to look out for.  I recommend you leave 

all three checked, so that you get theme words, 2-word phrases, 3-word phrases & 4-word phrases 

all returned. 

Once you have specified your options, click the large spider button: 
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Now, sit back and wait while the spider goes to work.  It can take a few minutes to return the data 

depending on internet connection speed and the speed of your computer. 

On my 2 year old laptop with 2 GB Ram and a 2.0 GHz  Intel Core Duo processor, the spider took 3 

and a half minutes when analyzing the top 1500 words per page. 

When the spider returns, it switches over to the Spider Results Tab: 

 

 

When the results open, you are on the theme words tab.  This lists all of the words found on the top 

pages, as well as the number of times the word appeared.  The higher the number, the more 

important the word on the pages, though be aware you will get words like “can”, “this”, “have” etc 

in the list as well.  Your next job is to place a check mark against each of the words you want to 

include.  You can scroll down the list of theme words selecting all words that you think are relevant 

to your niche.  If you are unsure about any word, check it anyway as you can always check this later 

with the “Compare against top 10” report we saw in the Editor section of this manual. 

When you have completed the theme words, switch to the 2 word phrases, then 3 and finally 4-

word phrases, and select any phrases that you want to target.   

Tip: I actually work from 4 word phrases backwards through 3, 2 and then theme words.  This means 

I can better evaluate the phrases.  E.g. on my two word phrases I have “diabetic alert”, which I might 

select, if I had not already seen and selected “diabetic alert dogs” on the three word phrase list. 
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When you have gone through each list and selected the words and phrases you want to target, 

switch to the Create Report Tab: 

 

The top section of this screen allows you to click the “Add Phrases to Article Theme Lists” button and 

automatically add all of the selected spider results to your theme lists. 

 

NOTE: If this button is greyed out, it means you have not opened or created a new article to hold the 

theme words.  Simply go to the article manager screen and create (or open) and article, then return 

here – your keywords will still be there. 

 

The bottom of this screen gives you a little extra flexibility.  Here you can create reports on your hard 

disk.  These phrase lists can be comma separated or separated by a new line, and they can include 

the counts (number of times the keyword appeared).  The types of reports are: 

 Text File – simple *.txt file. 

 HTML Report – A web page with the results. 

 Copy to Clipboard – copies the report to the clipboard. 

 

For the first two types of report, you need to specify an output folder where the reports will be 

created.  If you are using Vista, make sure you have permission to write to any folder you select 

here. 
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Keyword Spider and the Ignore List 
 

The keyword spider is extremely powerful at pulling out words and phrases from the top ranked 

pages, but it needs an “ignore list” to help decide which words are not important.  WCS comes with 

a standard ignore list but you can add your own items to this list as well.  

Basically, the ignore list should include small words like “it”, “the”, “and” etc (words that hold no 

significance to any particular niche) as well as single characters, numbers, strange punctuation etc 

that you want to ignore. 

When the spider collects its data, it will refer to the ignore list on your computer to decided if a 

particular single word is important or not.  Let’s take an example. 

If I run a Spider for the term “contact lens”, here is a small screen capture of part of the results that 

are returned: 

  

 

Note those two that are highlighted.  These are not “words” I am interested in, so I can select them 

one by one, and click the “Add HIGHLIGHTED word to the ignore list” menu. 

 

This then will add the word to the ignore list.  If I repeat for both of the “words”, the end of my 

ignore list now looks like: 
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Note that both “words” have been appended to the end.  You can access the Ignorelist Editor screen 

via the options menu.  If you manually edit it through this editor, be sure to save any changes using 

the save button, before closing. 

OK, with those two “words” added to my ignore list from the spider screen, I can remove any 2, 3 & 

4 word phrases that start or end with those two new ignorelist words by selecting the “Clean Phrase 

List” menu item: 

 

In other words, this will now go through my 2, 3 and 4 word phrases and remove any that start or 

finish with these “unimportant” words.  You can check to see if any are removed by looking at the 

status bar BEFORE: 

 

And AFTER cleaning: 

 

In this case, none were removed.  This section of the status bar shows the number of words or 

phrases in the theme words, 2 word, 3 word & 4 words lists.  The theme word (or 1 word phrase) list 

did not reduce because when we added those two words to the ignorelist, the counts were kept up 

to date. 

Now that these new ignore words have been added to the ignore list, next time I run the spider, 

these two words are missing from the theme word list: 

 

The arrow shows where they were in the previous run. 

Using the ignore list adds extra power to the spider because it means you can quickly get rid of 

words and phrases that have no value.  This allows for faster selection of theme words. 
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Other Buttons on the Theme Words Tabs 
 

 

We have already looked at the Ignorelist button. 

 

The Select All checkbox should be self explanatory as is the Invert Selection (which checks the 

unchecked and unchecks the checked) but I should discuss the “Add Currently Selected” button as 

many people misunderstand its purpose. 

This button is for ADDING ONE theme word or phrase to the list in your article.  It does not add all of 

the selected phrases.  The idea for having this button is that you go through the process of collecting 

words and phrases and then use the “Add Phrases to Article Theme Lists” button over on the reports 

tab.  However, you may, after having done that find one or two theme words you would like to also 

include.  This “Add Currently Selected” button is used for that.  It will add the one single currently 

highlighted word or phrase to your article theme word or phrase list. 

 

Next to this button is another button: 

  

This button simply returns you to the top of the list.  It saves all that scrolling if you have reached the 

bottom!
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Notes Tab 

The Notes tab actually has two sub-tabs – Notes and To Do List which are accessed on the far right of 

the screen: 

 

These are just tools to help you organise and keep important information safe and easily at hand.   

Notes and Todo Lists are assigned to a particular project - each project can have one Todolist, and 

multiple sets of notes.  Therefore, any notes or todo list you create when working on an article in a 

particular project will be visible when you open any other article in the same project. 

 

Notes 

From the scratchpad, you can send the contents of the scratchpad to the notes screen.  When you 

“Send To” Notes, a popup box appears asking for a name for the notes.  Type in a name, and the 

scratchpad contents become a set of notes. 
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In the screenshot above, I have selected Send To Notes and given the notes the name “Cameras”.  

When I click OK, the camera list appears as a new Note in my Notes list: 

 

Selecting the Cameras notes in the list displays those notes in the large editable region on the right.  

You have a few options for formatting the text in the Notes – bold, italics and underline.   

In the toolbar at the top, you can Add, Delete, Edit, Save and Cancel changes: 

 

The New Notes button allows you to create new notes from this screen (and not the scratchpad as 

we saw in the earlier example). 
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The Todolist 

 

Now, suppose that instead of sending that camera list to Notes, I sent them to the Todolist.  Here is 

what my Todolist now looks like: 

 

I know have a list of articles I want to write in my niche! 

I can specify whether the article is done yet, the status, priority, due date and even some notes 

about that todo item. 

There is a toolbar at the top that allows you to: 

 

Check All Items, Uncheck All Items, Delete Items marked as done and save todolist titles to a text file 

(great if you want a text file version of these items). 

The check box “Show Sorted”, if checked, allows you to order your todolist by clicking column 

headers.  That way you can have then in order of due date, or priority, etc. 
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The Data Files Used in Web Content Studio 
Windows does not like user data to be stored in the main program folder.  Windows Vista in 

particular tries to enforce this by making the program folders un-writable unless you are running the 

software as Administrator.  Because of this, I have created WCS so that your data is stored in the 

folders that your copy of Windows suggests.  You can see where that location is in the about screen: 

 

Now, while this makes Windows happy, it will frustrate a lot of users of WCS simply because 

Windows hides these folders by default.  If you want to add a new dictionary, chances are you won’t 

be able to find this folder because Windows is hiding it.  To make this folder visible, you need to tell 

windows not to hide it.  Here is how to do it. 

1.  Open Windows Explorer. 

2. In the Organize menu, select the Folder and Search Options item: 
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3. Click onto the view tab: 

 
 

4. Under the “Hidden files and folders” section, make sure you select the “Show hidden files 

and folders” radiobutton. 

5. Click OK to save. 

6. Your WCS data folder should now be accessible.   

7. If you want to hide these folders again, simply repeat the above steps but select the “Do not 

show hidden files and folders” radiobutton. 
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Repairing Databases & Backing Up your work 
 

From the Options Menu, select Backup & Repair Database.  The following screen opens: 

 

The top section is only used to repair & compact a broken database.  

Web Content Studio uses the same database system as both SEO Website Builder and KRA/KRA Pro.  

In those other program I have never experienced a corrupt database.  However, the option is there 

just in case and also if you want to compact your databases.  

Compacting a database will remove any “empty” space that was created from deleting existing 

articles or projects.   Whenever you repair the databases, WCS will look for problems and fix them, 

and then once it finishes that, it compacts them.  I suggest you do this periodically (once every 

couple of months) after you take a backup. 

To repair & compact the database system used in WCS, simply check all three boxes (don’t uncheck 

any of these unless you know exactly what you are doing).  Then click the Repair button.  Your 

databases will be repaired if necessary and then compacted, removing any empty space created 

from deleting articles, projects or other data. 
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If you just want to backup your data files, select a folder for the backups.  Whatever folder you 

choose for backups MUST allow you to write files to it.  E.g. on Windows Vista with User Accounts 

enabled, you cannot write to the program files folders or sub-directories.  I recommend you create a 

backup folder inside the WCS data folder (see About Box for location of this folder).  E.g. if your data 

folder is: 

C:\Users\Andy\Appdata\Roaming\Web Content Studio 

Create the following sub-folder: 

C:\Users\Andy\Appdata\Roaming\Web Content Studio\Backups 

You can then select this folder as your backup folder.   

NOTE: Windows hides these data folders by default, so see these instructions for unhiding the 

folder. 

Now, whenever you create a backup, WCS will create a sub-folder with date and time, and copy your 

data files there.  It also compacts the files as it copies them.  Below you can see one of these backup 

directories: 

 

.. and the files inside: 

 

 


